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Introduction 
The NI Volume License Manager Hands-On addresses many of the responsibilities of a software 
adminstrator, such as setup, deployment, and management of software licenses for users throughout an 
organization that uses National Instruments software, such as LabVIEW, TestStand, and DIAdem.  The 
optimal tool for assigning licenses, creating software distributions, and reporting usage is NI Volume 
License Manager 3.x.   

The following exercises will allow for several PCs to be attached to NI Volume License Manager via a 
network. 

 

Server 
NI Volume License 
Manager 3.x 
Windows 7 
Simulated DHCP Server 

  

    
  

 

Ethernet switch 
Unmanaged 
5-port 

    
    
    

    
Client A Client B Client C Client D 
Windows 7 Windows 7 Windows 7 Windows 7 
“Stand-alone ATE” “In-house Developer” “In-house Developer” 

and “Data Analyzer” 
“Short-term 
Contractor” 

Requires: Requires: Requires: Requires: 
TestStand (Full-time) TestStand (Part-time) TestStand (Part-time)  
 LabVIEW (Full-time) LabVIEW (Full-time)  
  DIAdem (Full-time)  
   Multisim (Full-time) 
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Exercise 1: Setup License on NI VLM 
Goal: Setup NI Volume License Manager (NI VLM) on the server PC with a pre-
configured NI License File. 

1. Launch NI Volume License Manager. 

 

Figure 1 

2. The first time NI VLM is launched, the NI VLM Getting Started Window is presented.  The window 
provides links to the help files describing the new features of the latest version of NI VLM.  Click 
Next. 

3. Select I have an agreement license file for this computer and click the […] to select the file 
NIHandsOn01.lic from the directory C:\Users\Public\Documents\NI VLM Hands-

On\Exercises\Exercise 1.   

4. Note: If you did not already have the license file, you would have to first select I do not have an 
agreement license file for this computer, to be guided through creating an email to 
agreements@ni.com which contains all the necessary details to build a license, such as Server name, 
Computer ID, Service ID, and license types. 
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Figure 2 

5. Select Do not import settings and click Next.  If upgrading from a previous installation of NI VLM, 
the other options in this window are used to import licensing settings and existing user permissions 
that had been backed up or exported. 

6. Enter representative data under Administrator Information.  Keep the default settings for Ports. 
Click Next. 

 

Figure 3 
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7. Select Allow NI VLM to send my VLA Log to National Instruments automatically.  Click Next.  The 
VLA Log stores usage information of NI VLM-controlled software, along with client information.  NI 
uses this information during the renewal of the VLA and is required. 

8. The Configure Email Preferences window can assist in connecting to your local mail server to send 
secure emails containing the VLA Log, receive Administrator Notifications, or email users their 
license files.  During this exercise, leave all fields as default and click Next. 

9. Click Finish.  NI VLM now contains the following licenses:  

Software Version Number of Licenses License Model 
Developer Suite Core 2 Computer-Based 
DIAdem Professional 2 Computer-Based 
Multisim Power Pro 2 Computer-Based 
TestStand Development System 2 Managed Concurrent  

Computer-Based 
 

10. The NI VLM service is not running yet on the volume license server and no users have been allocated 
licenses.  Before moving further, best practice is to first edit the system-wide preferences.  Navigate 
to Tools»Preferences from the main menu. 

 

Figure 4 
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11. In the General tab, set the fields as shown in the following figure. 

 

Figure 5 

12. In the Custom Fields tab, set all to Optional for the purpose of this exercise.  Read the pop-up 
message and click OK to ignore the message. 

13. Note: In your organization, select Required for the fields that are required for reporting and billing 
to cost centers.  The Full Name and Email address are required by NI when reporting software users 
who require access to the Standard Service Program. 

14. Explore the Notifications tab to learn more about this feature of the latest version of NI VLM.  When 
an email server is set up in NI VLM, notifications can be automatically sent to the administrator’s 
inbox as reminders for critical events, such as a license nearing expiration, or to create a backup of 
the user database for safe keeping.  Clicking Help on the bottom-left will explain these features 
further.  During this exercise, leave all fields as default.  
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15. In the VLA Policies tab, set the fields as in the following figure.  These settings allow administrators 
to implement NI Update Service policies to all client installations.  This can help ensure a level of 
software conformity across an organization. 

 

Figure 6 

16. Click Save to close the Preferences window. 

17. Click Apply Changes.  Apply Changes must always be clicked when any change is made to NI VLM 
before it is visible to the network. 

18. Click Start Volume License Server if it has not already been started. 

 

Figure 7 

19. Continue to Exercise 2. 

End of Exercise 1 
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Exercise 2: Managing Groups with NI VLM  
Goal: Manage users and licenses effectively with Groups in NI VLM. 

Groups are a collection of licenses and clients. Every client in a given group has permission for each 
license in that group. You can use groups to define a set of clients that use the same set of software, 
according to the roles played by engineers in your organization. 

1. Review the Introduction section of this document to understand the organization’s license 
requirements. 

2. In the main NI VLM window, select the Groups view. 

3. Click Add Computer Group. 

 

Figure 8 

4. Set the Name to Production Test. Set the Description to Machines that run Test Sequences. 

5. Click Add to the right of the Licenses field. 

6. Check TestStand Development System and click Add.  Click Save. 

7. Click Add Computer Group. 

8. Set the Name to Test Developer. Set the Description to Machines for Developing Tests. 

9. Click Add to the right of the Licenses field. 

10. Check Developer Suite and TestStand Development System and click Add.  Click Save. 

11. Click Apply Changes.  Apply Changes must always be clicked when any change is made to NI VLM 
before it is visible to the network. 

12. Continue to Exercise 3. 

End of Exercise 2 
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Exercise 3a: Configure Clients for NI VLM 
Goal: Inspect the client PCs, prepare them for installing software, and link them to 
the NI VLM server. 

Option I: If you have access to client hardware 
1. Log into Windows on all client PCs. 

2. Navigate to Start»All Programs»National Instruments»NI License Manager. 

 

Figure 9 

3. Click on Display Computer Information or press F7. 

 

Figure 10 
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4. Record the Computer Name and Computer ID of every client on a sheet of paper or in Notepad.  
Decide which machine will be client A through D, as described in the Introduction. 

5. Clients can be added to NI VLM in the following three ways: 

a. Manually, as part of a group. (ClientA) 

b. Manually, without being assigned to a group. (ClientD) 

c. Automatically, via a distributed Volume License Installer (VLI). (ClientsB and C) 

Note: The clients will be added using the above methods in the following exercises. 

6. Continue to the next part of Exercise 3. 

Option II: If you do not have access to client hardware 
1. Review the client PC information that has already been collected using the method in Option I. 

Computer Name Computer ID 
ClientA JKBL-Y54Q-PD7Z-2CBP 
ClientB R8PD-NKC7-GLW8-Q2VX 
ClientC Y2VB-YY7S-9VCR-B8DB 
ClientD Y2V5-7S7M-TH6M-X6BD 
 

2. Clients can be added to NI VLM in the following three ways: 

a. Manually, as part of a group. (ClientA) 

b. Manually, without being assigned to a group. (ClientD) 

c. Automatically, via a distributed Volume License Installer (VLI). (ClientsB and C) 

Note: The clients will be added using the above methods in the following exercises. 

3. Continue to the next part of Exercise 3. 
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Exercise 3b: Manually adding Clients to NI VLM 
Goal: Use NI VLM to add two of the client machines manually. 

For networks with a small number of machines, it may be faster to manually add machines to NI VLM, 
either within an existing group, or standalone with an explicit license.  For larger networks, Exercise 3c 
explores automating the addition of clients to NI VLM. 

1.  On the NI VLM server, navigate to the Computers view of the main NI VLM window. 

2. Click Add Computer. 

 

Figure 11 

3. Set the Computer Name and Computer ID to the values logged in Step 4 for ClientA. Be sure to use 
computer names without spaces, as Windows and NI VLM do not support computer names with 
spaces. 

4. Click Add to the right of the Groups field. 

5. Check Production Test and click Add.  Click Save. 

6. On the NI VLM server, navigate to the Computers view of the main NI VLM window. 

7. Click Add Computer. 

 

Figure 12 

8. Set the Computer Name and Computer ID to the value logged in Step 4 for ClientD. 
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9. Click Add to the right of the Explicit Licenses field. 

10. Check Multisim Power Pro Edition and click Add.  Click Save. 

11. Click Apply Changes.  Apply Changes must always be clicked when any change is made to NI VLM 
before it is visible to the network. 

Option I: If you have access to client hardware 
12. Log into Windows onto the ClientA and ClientD PCs. 

13. Navigate to Start»All Programs»National Instruments»NI License Manager. 

14. In the main menu, navigate to Optons»Preferences. 

 

Figure 13 

15. Check the box for Use Volume License Servers and enter the Server Name or IP Address. 

 

Figure 14 
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16. Click OK.  Expand the [+] next to the server name to inspect whether the server and clients are 
communicating.  ClientA should have a green box next to the Product Test group and the TestStand 
volume license.  ClientD should only have a green box next the Multisim volume license. 

 

Figure 15 

17. Close the NI License Manager. 

18. Run TestStand on ClientA or Multisim on ClientD.  If licensing has been negotiated correctly with NI 
VLM, then the application should start immediately.  If a licensing error has occurred with NI VLM, 
you should see a message similar to the figure.  Click more details... to learn more about the error. 

 

Figure 16 

19. Continue to the next part of Exercise 3. 
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Option II: If you do not have access to client hardware 
12. Assume that the required clients have been configured as in Option I. 

13. Continue to the next part of Exercise 3. 
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Exercise 3c: Automatically adding Clients to NI VLM with a silent VLI 
Goal: Automate the process of installing NI software on multiple machines and 
distributing licenses with a Volume License Installer (VLI). 

ClientB and ClientC are similar machines which both require access to the NI VLM group named Test 
Developer.  A VLI automates the process of ensuring several clients install the same NI software, link to 
the correct license server, and request a license from the appropriate group.  Several command line 
switches exist for the VLI to assist the administrator in reducing human error among clients. 

1. On the NI VLM server, navigate to Tools»Create Volume License Installer.... 

 

Figure 17 

2. Click Next. 

3. Set the Source to C:\Users\Public\Documents\NI VLM Hands-On\Exercises\TestStand 
201#. 

4. Set the Destination to C:\Users\Public\Documents\NI VLM Hands-On\Exercises\VLI. 

5. Enter TestStand_VLI as the Installer Name. Click Next. 
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Figure 18 

6. Select Configure Clients to connect to volume license server to check out licenses and allow the 
default server name.  Click Next. 

7. Select Do not allow clients to request permission to join any groups and check Collect client 
information and send it to NI Volume License Manager. These settings are necessary to disable a 
dialog box for users to choose groups. 

 

Figure 19 

8. Click Next and Build.  Wait for the build to complete and click Finish. 
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9. In Windows, navigate to C:\Users\Public\Documents\NI VLM Hands-

On\Exercises\VLI\TestStand_VLI.   

10. Note: The folder now has the TestStand DVD contents in _Src.  A special utility, called vlmclient.exe, 
which is used to automatically configure the client with the server, is stored inside Client.  Setup.exe 
in the top-level folder would install TestStand on the client and then configure NI License Manager 
to communicate with the NI VLM server. If software is already installed on the client, it is advised 
you only run vlmclient.exe to configure the NI License Manager.  This feature can also be used help 
migrate several users to a server with a new name on the network.   

11. Navigate to C:\Users\Public\Documents\NI VLM Hands-On\Exercises\Batch Files to 
find a pre-made batch file.  For a completely silent client experience, vlmclient.exe must be run in a 
Batch file (.bat) with command line switches /q for quiet and /groups to add ClientB and ClientC to 
the Test Developer group.   

12. Right-click on VLMclientwithGroups.bat and select Edit. 

13. Above the text Pause, type the command Client\vlmclient.exe /q /groups {GUID}.  The 
Group Unique ID (GUID) can only be found through NI VLM by following the next three steps.   

14. Note: Do not use /q if you would like users to enter their Full name and email address for NI 
Technical Support through the Standard Service Program. 

15. In NI VLM, navigate to the Groups view. 

16. Click on the Test Developer group and click Edit. 

 

Figure 20 

17. Right-click on the icon in the top left corner and select Copy Group Unique ID.  
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Figure 21 

18. In the batch file, double-click on {GUID}, right-click and select Paste. 

 

Figure 22 

19. Navigate to File»Save and Close the batch file. 

20. Close all open NI VLM windows.  The Automatic Permission Handling about to be tested requires 
that the NI VLM window is not running on the network in order to work as expected. 

21. Copy the Batch file to C:\Users\Public\Documents\NI VLM Hands-

On\Exercises\VLI\Installer for Clients.  Copy the folder Client from 
C:\Users\Public\Documents\NI VLM Hands-On\Exercises\VLI\TestStand_VLI to the 
same location so it has the same structure as the figure. 

 

Figure 23 

Option I: If you have access to client hardware 
22. Distribute the folder, Installer for Clients, via USB stick or the network to ClientB and ClientC.  Paste 

the folder in the location of your choice on both client PCs. 

23. Verify that the NI VLM window is closed on the volume license server.   
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24. Note:  Automatic permission request handling is disabled while the user interface is open. Requests 
are stored in the Permission Queue, and you can either approve or deny requests while using NI 
VLM. 

25. Double-click VLMclientwithGroups.bat on the clients and follow the instructions. 

26. Navigate to Start»All Programs»National Instruments»NI License Manager. 

27.  Expand the [+] next to the server name to inspect whether the server and clients are 
communicating.  ClientB and ClientC should have a green box next to the Test Developer group and 
both the Developer Suite and TestStand Volume License.  

  

Figure 24 

28. Close the NI License Manager. 

29. Continue to Exercise 4. 

Option II: If you do not have access to client hardware 
22. Continue to Exercise 4. 

End of Exercise 3 
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Exercise 4: Disconnecting licenses from NI VLM 
Goal: Disconnect licenses from NI VLM to permanently reserve a license for a client 
or to allow a client to use software without network access. 

Option I: If you have access to client hardware 
1. Run the TestStand Sequence Editor on ClientA, B, and C by navigating to Start»All 

Programs»National Instruments»TestStand 201#»Sequence Editor. NI VLM contains two 
concurrent licenses, however three machines are trying to access the licenses.  One of the three 
clients will be denied a license until an existing user stops running TestStand. 

2. In your organization, ClientA represents a piece of Automated Test Equipment that must never be 
denied a license when it performs a production run.  In response to your client’s request, as an 
Administrator, you can investigate which machines are using the concurrent licenses.  In NI VLM, 
navigate to Licenses. 

3. Expand the [+] next to Development System, under the category TestStand 201#.  Click the In Use 
tab to view the current usage of this license.  You have decided that the best way to assist your 
client is to permanently reserve a single license from the concurrent pool for ClientA.  ClientA will 
also be able to use software without a network connection. 

4. Navigate to the Computers view in NI VLM on the server.  

5. Click once on ClientA under Computer Name and select Disconnect. 

 

Figure 25 

6. Click Next. 

7. Select Save disconnected license file and click on the [...] to navigate Windows Explorer to 
C:\Users\Public\Documents\NI VLM Hands-On\Exercises\Disconnected Licenses 
and click OK. 

8. Click Next. 
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9. Select Never Expire. Click Disconnect. 

10. Click Apply Changes.   

11. Note: When the disconnected license file is applied to ClientA, it will be able to always use TestStand 
without the chance of its license being borrowed by another computer on the network. 

12. Optional: Test the configuration by copying the disconnected license file to ClientA via a USB stick.  
Install the license file by pressing F8 in NI License Manager. Notice that ClientB and ClientC 
negotiate the remaining license between themselves, however, ClientA always has a TestStand 
license. 

13. ClientD represents a contractor who will be joining your organization for 3 months as a temporary 
circuit designer.  ClientD will not be allowed access to the network and also cannot be given serial 
numbers for a standalone software seat of Multisim.  ClientD will be given a three-month license 
from the Computers view of NI VLM.   

14. Click once on ClientD under Computer Name and select Disconnect. 

 

Figure 26 

15. Click Next. 

16. Select Save disconnected license file and click on the [...] to navigate Windows Explorer to 
C:\Users\Public\Documents\NI VLM Hands-On\Exercises\Disconnected Licenses 
and click OK. 

17. Click Next. 

18. Select Expire on a specific date and select a day 3 months from today. Click Disconnect. Click Finish. 

19. Click Apply Changes.   

20. Note: When the disconnected license is applied to ClientD, it will be able to run Multisim for the 
period of time the contractor is working with your organization.  When the license expires, the risk 
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of abuse of your organization’s licenses is reduced.  The license is automatically reconnected to NI 
VLM on the same date. 

21. Optional: Test the configuration by copying the disconnected license file to ClientD via a USB stick.  
Install the license file by pressing F8 in NI License Manager. Notice that ClientD can run Multisim 
even when disconnected from the Ethernet network.  The expiration date is also listed on the right-
hand side of the NI License Manager window. 

22. Continue to Exercise 5. 

Option II: If you do not have access to client hardware 
1. In your organization, ClientA represents a piece of Automated Test Equipment that must never be 

denied a license when it performs a production run.  In response to your client’s request, as an 
Administrator, you can investigate which machines are using the concurrent licenses.  In NI VLM, 
navigate to Licenses. 

2. Expand the [+] next to Development System, under the category TestStand 201#.  Click the In Use 
tab to view the current usage of this license.  You have decided that the best way to assist your 
client is to permanently reserve a single license from the concurrent pool for ClientA.  ClientA will 
also be able to use software without a network connection. 

3. Navigate to the Computers view in NI VLM on the server.  

4. Click once on ClientA under Computer Name and select Disconnect. 

 

Figure 27 

5. Click Next. 

6. Select Save disconnected license file and click on the [...] to navigate Windows Explorer to 
C:\Users\Public\Documents\NI VLM Hands-On\Exercises\Disconnected Licenses 
and click OK. 

7. Click Next. 
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8. Select Never Expire. Click Disconnect. 

9. Click Apply Changes.   

10. Note: When the disconnected license file is applied to ClientA, it will be able to always use TestStand 
without the chance of its license being borrowed by another computer on the network. 

11. ClientD represents a contractor who will be joining your organization for 3 months as a temporary 
circuit designer.  ClientD will not be allowed access to the network and also cannot be given serial 
numbers for a standalone software seat of Multisim.  ClientD will be given a three-month license 
from the Computers view of NI VLM.   

12. Click once on ClientD under Computer Name and select Disconnect. 

 

Figure 28 

13. Click Next. 

14. Select Save disconnected license file and click on the [...] to navigate Windows Explorer to 
C:\Users\Public\Documents\NI VLM Hands-On\Exercises\Disconnected Licenses 
and click OK. 

15. Click Next. 

16. Select Expire on a specific date and select a day 3 months from today. Click Disconnect. Click Finish. 

17. Click Apply Changes.   

18. Note: When the disconnected license is applied to ClientD, it will be able to run Multisim for the 
period of time the contractor is working with your organization.  When the license expires, the risk 
of abuse of your organization’s licenses is reduced.  The license is automatically reconnected to NI 
VLM on the same date. 

19. Continue to Exercise 5. 

End of Exercise 4 
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Exercise 5: Generate report with NI VLM usage data 
Goal: Create a visual representation of the check-out and check-in operations on 
the NI VLM server in order to improve license management. 

1. The latest version of NI VLM includes built-in report generation based on the usage data logged over 
the volume license period.  Due to the fact that there has not been enough client activity during the 
exercises, NI VLM’s configuration will be reset, and a file of simulated data will be loaded. 

2. In NI VLM, in Status, click Stop Volume License Server.  

 

Figure 29 

3. Close the NI VLM window. 

4. In Windows Explorer, navigate to C:\Users\Public\Documents\NI VLM Hands-

On\Exercises\CleanUp and run the batch file Run this to Clean VLM 3.1 and make it 
like a Fresh Install.bat by right-clicking and selecting Run as Administrator. 

 

Figure 30 
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5. Click OK on the Windows UAC dialog box.  Answer Y for every question in the NI VLM cleaner tool to 
delete all configuration files. 

6. Launch NI Volume License Manager. 

 

Figure 31 

7. Click Next. 

8. Select I have an agreement license file for this computer and click the […] to select the file 
NIHandsOn01.lic from the directory C:\Users\Public\Documents\NI VLM Hands-

On\Exercises\Exercise 1.   

 

Figure 32 
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9. Select Import settings from a previous NI VLM 3.x installation and click Next.  . 

 

Figure 33 

10. Load the file ReportingTesting.vlmbak from C:\Users\Public\Documents\NI VLM 

Hands-On\Exercises\Reporting and click Import. 

 

Figure 34 

11. Click Next, Next, and Finish. 

12. In the main NI VLM window, select the Reports view.   

Note: NI VLM Reports view can be used to create the following reports: 
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 License Activity shows how many hours each client used the specified license.  
 Client Activity shows how many hours a specified client used each license.  
 Seat Utilization shows how many seats of a specified license each client used over time and 

provides detailed information about any overdrafts.  
 Seat Utilization (Concurrent) shows how many seats of a specified license each client used over 

time and whether any clients were unable to check out the license because no seats were 
available.  

 License Allocation shows, over time, how many seats each portion of your organization used, so 
that you can allocate costs accordingly.  

 License Allocation (Concurrent) shows how many hours each portion of your organization used 
each license, so that you can allocate costs accordingly.  

 Named-User EULA Compliance shows any instances of a client using a named-user license on 
more than three computers. 

13. Select Seat Utilization.  Configure the dates of interest, the license to inspect, and click Generate 
Report.  Recommended values are in the figure below. 

 

Figure 35 

14. Review the report.  The solid line represents the number of licenses available.  The report shows 
that between January and March, more licenses were used than expected, via the overdraft system.  
This could indicate an unplanned trend in your organization, which implies that more licenses are 
needed that time of year. 

 

Figure 36 
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15. Select Seat Utilization (Concurrent).  Configure the dates of interest, the license to inspect, and click 
Generate Report.  Recommended values are in the figure below. 

 

Figure 37 

16. Review the report.  The top graph indicates the Seats in Use per day.  The bottom graph indicates 
when more seats than available were requested.  The clients requesting above the inclusive amount 
were denied, and logged. If the list is long, that could indicate that the organization should acquire 
more licenses. 

 

Figure 38 

17. Select License Allocation.  Choose any parameters and click Generate Report.  This report can help 
classify usage in your organization.  This tool can help when allocating cost to different Cost Centers, 
Projects, or Departments. 

18. Continue to explore additional reporting features. 

End of Exercise 5 
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